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Contents of Package:
D-Link DP-301P+
Pocket Size Print Server
Manual and Warranty on CD

Printed Quick Installation Guide

Package Contents

If any of the above items are missing, please contact your reseller.

System Requirements:

�

�

�

 A  computer with an installed Ethernet adapter�

Windows XP/2000/NT4/Me/98SE�

Apple Mac OS with AppleTalk�

Linux�

NetWare 5.x or above (Native NDS)�

Internet Explorer 6.0, or Netscape Navigator version 6.0 or above,
with JavaScript enabled

�

Printer must support required Operating System�
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The D-Link DP-301P+ Print Server is a pocket size print server that connects to
your Ethernet/Fast Ethernet network anywhere you wish to locate printer services.
The DP-301P+ manages the flow of print files from workstations or file servers to
connected printers, delivering print jobs to printers much faster than a file server or
a PC acting as a print server.

The DP-301P+ includes easy-to-use software to install on most Windows-based
networks. Protocol support for TCP/IP, NetBEUI, and AppleTalk are provided to
ensure seamless connection to major networking operating systems.

The DP-301P+ has a built in Web-based management feature that allows users to
easily configure and manage multiple print queues through TCP/IP. The DP-301P+
also supports Telnet as an alternative method to configure the unit.

The DP-301P+ improves network printing services in the following ways:

Introduction

�

The DP-301P+ manages print file traffic.  This provides workload relief
to your file servers, and allows the file servers’ full capacity to be used
for file access or other direct services to network users. On Peer-to-
Peer networks, workstations can print directly to the print server
without increasing the load of another workstation or server.

Because the DP-301P+ is very portable and inexpensive compared to
a PC-based print server, and the print server connects to your file
servers through the network, printers can be deployed to locations of
maximum convenience to users.

�
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External Features
Port Connectors
The DP-301P+’s parallel port is located on its front panel. The port can be
configured using the PS Admin program or the print server’s Telnet interface. (See
the PS Admin User’s Guide, available on the CD that came with the DP-301P+, for
information about configuring the print server’s ports.) The print server also
supports web configuration permitting users to configure settings through the web
browser. The default IP address is as follows:

� Default IP address – 192.168.0.10

� Subnet mask – 255.255.255.0

The DP-301P+ offers extraordinary flexibility, operating with all major network
operating systems and protocols:

� TCP/IP

UNIX lpr/lpd (HP-UX, Sun OS, Solaris, SCO, UnixWare, IBM AIX)
Windows NT/2000, Windows 95/98SE/Me, Windows XP
NetWare 5.x NDPS LPR Remote Printing

� NetBEUI

Windows NT/2000/XP, Windows 95/98SE/Me, Windows for Workgroups,
Microsoft LAN Manager, IBM LAN Server

� AppleTalk

Mac OS EtherTalk

Windows-based setup and administration software, PS Admin, is supplied with the
print server, making configuration and management quick and easy. The print
server also supports configuration and management via the Telnet protocol for
networks without Windows-compatible machines.

Note:
The PC’s IP address must be in the same subnet as the print server’s IP address for the
two devices to communicate. (For example, if your print server’s IP address is
192.168.0.10, with a subnet mask of 255.255.255.0, then your computer’s IP address
should be 192.168.0.x, where x is a value between 1-254, excluding 10.)
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Ethernet Port - Network Cable Connector
The print server’s rear panel features an RJ-45 connector for connection to
10Base-T Ethernet cabling or 100Base-TX Fast Ethernet cabling (which should be
CAT5 twisted-pair cable). The port supports the NWay protocol, allowing the print
server to automatically detect or negotiate the transmission speed of the network.
Use this port to connect to your network router.

Power - DC Power Connector
The DC power input connector is located on the print server’s rear panel .

LED Indicators
The back panel of the print server features three LED indicators:

ACT - Lights up to indicate activity on the network.

LPT - Lights up to indicate printing activity.

   l    - Lights up to indicate that the DP-301P+ is powered ON.

Rear Panel

Power

LEDs

Ethernet
Port
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Front Panel

Parallel Port Connector
The front panel of the print server features the parallel port connector. Plug this
connector directly into the parallel port on your network printer. There is no need for
a parallel port cable between the print server and your network printer.
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 Setting up the DP-301P+
Installing the Print Server

WARNING: Configuration problems may result if the print server is powered
up without first establishing its network connection. Follow this procedure to
avoid complications at the configuration stage.

Plug the AC power adapter’s DC output plug into the DC 5V power socket on
the print server.

7.

Plug the power adapter into a power outlet. This will supply power to the print
server, as it has no external power switch. The green Power LED on the Print
Server’s front panel should illuminate steadily, and the Print Server’s Self-Test
will proceed.

8.

Switch on the connected printer.6.

While the printer is powered OFF, install the DP-301P+ parallel port connector
into the parallel port on the network printer.

5.

Connect the DP-301P+ RJ-45 Connector to the network, using an Ethernet
CAT5 cable.

4.

Confirm that your network is operating normally.3.

When you have confirmed proper operation of the printer, switch its power2.

Confirm proper operation of  the printers to be connected to the DP-301P+.1.

Power ON Self-Test
Every DP-301P+ has been factory-tested to operate properly.

Whenever the DP-301P+ is powered up, two testing procedures follow
automatically. The first procedure is a programmed series of flashes intended to
confirm proper operation of the LED indicators. The second procedure comprises
programmed tests of the DP-301P+’s internal circuitry. If any fault is found during
the circuitry tests, testing stops and a continuous pattern of flashes signals the
nature of the fault.
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Immediately upon power-up, the         (Power) and LPT indicators will illuminate
steadily in green for several seconds. Then the LPT indicator will become dark
while the    (Power) indicator remains steady. Irregularity of any indicator during
this test indicates that there is a problem with the indicators themselves.

 1
 1

Indicator Test

LPT LED Flash Pattern Error Type

Steady long flashes Firmware Reload Required

DRAM Error

One long, two short flashes

One long, three short flashes

One long, five short flashes

One long, six short flashes

One long, eight short flashes

One long, nine short flashes LPT Error

Parallel Controller Error

LAN Controller error

Flash Erase/Program error

Flash Protected

Timer INT error

One long, fourteen short flashes LAN PHY error

Continuously on

The circuit tests immediately follow the indicator test. A normal (no fault) result is
signaled by three flashes of the LPT indicator and the start of normal print server
operation. If any error condition is found during the circuit tests, testing will halt with
the LPT indicator continuously signaling the particular error according to the
following table:

Circuit Tests

In the event of a Firmware Reload Required error at startup, proceed according to
instructions given in the PS Admin User’s Guide (“PS Admin Administration”
section, under the heading “Upgrading the Print Server’s Internal Firmware”).
The PS Admin software includes a Print Test function for confirmation of print server connections and
functions. This operational test can be performed after you have installed the PS Admin software and
completed the PS Admin procedures for configuring the DP-301P+. See the instructions given in the PS Admin
Users Guide (“Getting Started Setting up Your Print Server” section, under the heading “Testing your Print
Server”).
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Getting Started

For a list of printers that are compatible with the DP-301P+, please see the
Appendix in this manual. The compatibility list is not comprehensive. Even if it
is not included in the list, your printer may be compatible with the DP-301P+.

Below is a sample network using the DP-301P+. The DP-301P+ has a built-
in Web-based management feature that allows users to easily configure
and manage multiple print queues through TCP/IP.
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Open your web browser and type http://
192.168.0.10 in the address box, and press
Enter. This set of numbers is the default IP
address of your print server.  Please note that
the PC’s IP address must correspond with
the print server’s IP address in the same
segment for the two devices to
communicate.

Using the  Web Configuration

Home > System

This  tab displays the system
information, providing general
information regarding the print
server. Click on the Refresh
button to acquire the most
updated information. Once a
printer is connected to the print
server, the Printer Status will
be displayed.

Server Name: The name
assigned to the print server.

Model: The model of the print
server.

Hardware Version: The
version of the hardware on the
print server.

Firmware Version: The version
of the firmware and release date
on the print server.

Device Status

MAC Address: The MAC address of the Ethernet port.

IP Address: The IP address of the print server.

Up Time: The length of time the print server has been up.

This screen also displays information about the Printer Status and the Ethernet
Status.

http://192.168.0.10
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Using the  Web Configuration (continued)

Home > Network

This screen contains
information regarding Auto IP,
TCP/IP Printing, Microsoft
Network Printing, and MAC
AppleTalk Printing.

Home > User

This screen displays the
User’s Printing Log.
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Server Name: The name assigned to the print server.

Location: Input a comment indicating where the print server is located. (optional)

Admin Contact: The name of the print server’s administrator. (optional)

Password: By default the DP-301P+ does not have a password. For security, you
may wish to enter a password.

Port Name: This is the assigned name for the parallel port.

Description: A  brief description for the parallel port. (optional)

Speed: Select high or low printer port speed.

PJL Printer: This feature is used to support the Hewlett-Packard PJL (Printer Job
Language) standard for bi-directional printing.

Using the  Web Configuration (continued)

Configuration > System

The Configuration window will display the settings required to configure the DP-
301P+ Print Server. Consult your printer’s manual for the PJL (Printer Job Lan-
guage) and print speed supported on your printer. Click Save on the bottom of the
configuration page to ensure the settings are updated and saved.
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Configuration > Network

Using the  Web Configuration (continued)
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Chooser Name: Enter the printer name.
Printer Type: Enter the printer type.
PostScript Level: Enter the PostScript level.
Font Group: Enter the font group.

Configuration > Network (continued)
Using the  Web Configuration (continued)

Save: Click Apply to save the changes.

IP Address: The default  IP address is 192.168.0.10
Subnet Mask: The default  subnet mask is 255.255.255.0
Default Gateway: Enter the IP address of the default gateway
(router).

Workgroup: Computers in the same network must have the same
Workgroup name.

TCP/IP Protocol

Microsoft Network

AppleTalk

Manually Assign: To manually assign an IP address please provide the
following information:

Automatically  Assign: Select this option to receive an IP address auto-
matically.

IP Address

DNS Server Address: A Domain Name Server (DNS) translates a domain
name into an IP address. Enter the IP address of the DNS server here.

UPnP: Enable UPnP (Universal Plug and Play ) here. UPnP makes installation
easier if all the communicating devices also have UPnP enabled.

MAC Rendevous: Select Enable for ease of use with Mac OS X computers.

Second HTTP Port: Select Enable and enter a Port Number for remote web con-
figuration and IPP Printing. (IPP is a Web-based printer management)

AppleTalk Zone: Enter an asterisk.

LPT
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Enable User Printing Control: To control access to the printer click Enable.

Using the  Web Configuration (continued)

Configuration > User

Printing Control

Define Users

Add User: Enter the User Name, the MAC Address, click Yes or No for Print-
ing Access and then click Add.

User List: You can delete a user in the list by putting a check in the box to the left
of the name and clicking Delete.
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Configure your SNMP here.

Using the  Web Configuration (continued)

Configuration > SNMP

Tools > Print Test

Click Apply to print a test
page.
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Email Account:
Configure the Print
Server’s email ac-
count here.

Using the  Web Configuration (continued)
Tools > Email

Email Notification:
Click Yes to enable
email notification for
printer status change.

Test: Click Test to
send an email to the
Admin account.

Email printing: Click
Yes to enable email
printing. (only the text)

Receive email
interval: Enter the
length of time be-
tween emails here.

Receive: Click
Receive to get
emails and printouts.

Tools > Reset

Reset: Click Apply to
reset the DP-301P+.

Factory Reset: Click
Apply to reset the DP-
301P+ to the factory
default settings.

You will
lose your
current

settings if you Reset
the DP-301P+.
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Firmware Upgrade:
Visit the D-Link support
site at http://
support.dlink.com to find
the latest firmware
upgrade. Copy it to your
hard drive.Then click
Browse in this window
to select the upgrade
and click Apply. Your
firmware upgrade is
complete.

Using the  Web Configuration (continued)

Tools > Upgrade

Tools > Backup

Backup Device
Configuration to File:
Click Apply to make a
backup copy of your
current configuration.

Restore Device
Configuration from
File: Click Browse to
browse your hard drive
for backup configuration
files. After you have
selected a file click
Apply.
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Using the  Web Configuration (continued)

Help

Help: Click on any item in the Help menu for more information.
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TCP/IP Printing for Windows XP
Open the web browser, and type in the IP address of the DP-301P+.
Type http://192.168.0.10 into the Location or Address field. Press Enter.

Note:
The PC’s IP address must be in the same subnet as the print server’s IP
address for the two devices to communicate. (For example, if your print
server’s IP address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP address.

http://192.168.0.10



22

TCP/IP Printing for Windows XP (continued)

At the Configuration  window,  write down the Port Name for future reference.
You will need this information later in the configuration process.
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TCP/IP Printing for Windows XP (continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you
need to make changes, make sure to click Save after you have made the
changes. (You may wish to make a note of the IP address.)
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Go to Start > Settings >
Printers and Faxes >
Add a Printer.

Click Next.

TCP/IP Printing for Windows XP (continued)
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TCP/IP Printing for Windows XP (continued)

Select Local Printer.

Click Next.

Select Create a new port. At the
pull-down menu, highlight
Standard TCP/IP Port.

Click Next.

Click Next.

Deselect Automatically
detect and install my
Plug and Play printer.
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TCP/IP Printing for Windows XP (continued)

Type in the IP
address of the
print server (i.e.
192.168.0.10).
The Port Name
will automatically
be filled in.

Select Standard.

Click Next.

Click Finish.
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At this screen, you can input a name
for the printer.

Click Next.

Click Next.

TCP/IP Printing for Windows XP (continued)

Highlight the printer, as shown.
If the desired printer is not on
the list, click Have Disk and
insert the printer driver disk that
came with your printer to install
the printer drivers.

Click Next.
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Click Finish.

TCP/IP Printing for Windows XP (continued)

Epson Stylus COLOR 740 ESC/P2

Epson Stylus
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TCP/IP Printing for Windows 2000
Open the web browser, and type in the IP address of the DP-301P+.
Type http://192.168.0.10 into the Location or Address field. Press Enter.

Note:
The PC’s IP address must be in the same subnet as the print server’s IP
address for the two devices to communicate. (For example, if your print
server’s IP address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP address.

http://192.168.0.10
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TCP/IP Printing for Windows 2000 (continued)

At the Configuration  window,  write down the Port Name for future reference.
You will need this information later in the configuration process.
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TCP/IP Printing for Windows 2000 (continued)

When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you
need to make changes, make sure to click Save after you have made the
changes. (You may wish to make a note of the IP address.)
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Go to Start > Settings >
Printers

Double-click on the Add
Printer icon.

Click Next.

TCP/IP Printing for Windows 2000 (continued)
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TCP/IP Printing for Windows 2000 (continued)

Select Local Printer.

Click Next.

Select Create a new port at the
pull-down menu,
highlight Standard TCP/IP Port.

Click Next.
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TCP/IP Printing for Windows 2000 (continued)

Click Next.

Click Next.

Type in the IP address of the print
server in the Printer
Name or IP Address field. The
Port Name field will
automatically be filled in.

Select Standard.

Click Next.
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TCP/IP Printing for Windows 2000 (continued)

Click Finish.

Click Next.

At this screen, you can input a
name for the printer.

Click Next.

Highlight the printer, as shown.
If the desired printer is not on
the list, click Have Disk and
insert the printer driver disk that
came with your printer to install
the printer drivers.
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TCP/IP Printing for Windows 2000 (continued)

Click Next.

Select Yes to print a test page.

Click Next.

Click Finish.

The printer is now ready for
printing with Windows
2000  on your network.

Select Do not share this printer.

.
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TCP/IP Printing for Windows 98SE/Me
Open the web browser, and type in the IP address of the DP-301P+.
Type http://192.168.0.10 into the Location or Address field. Press Enter.

Note:
The PC’s IP address must be in the same subnet as the print server’s IP
address for the two devices to communicate. (For example, if your print
server’s IP address is 192.168.0.10, with a subnet mask of 255.255.255.0,
then your computer’s IP address should be 192.168.0.x, where x is a value
between 1-254, excluding 10.) See Networking Basics: Assigning a Static IP
Address in this manual to find out how to change an IP address.

http://192.168.0.10
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TCP/IP Printing for Windows 98SE/Me
(continued)

At the Configuration  window,  write down the Port Name for future reference.
You will need this information later in the configuration process. The Port Name
shown here is only an example.
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When you select TCP/IP Protocol at the Network window, the screen below
appears. (We recommend that you keep the default settings as shown.) If you
need to make changes, make sure to click Save after you have made the
changes. (You may wish to make a note of the IP address.)

TCP/IP Printing for Windows 98SE/Me(continued)



40

TCP/IP Printing for Windows 98SE/Me (continued)

Click Add.

Highlight Client.

Click Add.

Go to Start > Settings >
Control Panel.
Double-click on Network.

The screen shown at the
right  will appear.
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 TCP/IP Printing for Windows 98SE/Me (continued)

At this window,
click Have Disk.

Click OK to accept the
location of the file.

23

1

4

1.

2.

3. Highlight lpr.inf.

4. Click OK.

Insert the DP-301P+
CD-ROM into your
CD-ROM  drive.
Select the letter
representing the
CD-ROM drive on
your computer from
the pull-down menu.

Double-click on
the folder lpr.
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TCP/IP Printing for Windows 98SE/Me (continued)

Click OK.

You should now be
back to the Network
Properties Page.
Highlight LPR for
TCP/IP Printing.

Click Properties.
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TCP/IP Printing for Windows 98SE/Me (continued)

The Port Name and IP
address will be displayed.
(The Port Name at right is
just an example.)

Click OK.

Type in the IP address of
the DP-301P+. Make sure
the Port Name is accu-
rate. (The Port Name at
right is just an example.)

Click OK.

Click Add Port.

PS-116688-P1

192.168.0.10/PS-116688-P1
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Click OK.

Windows will ask
for a restart.

Click Yes.

TCP/IP Printing for Windows 98SE/Me (continued)
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Once your computer has rebooted, click on
Start  > Settings  > Printers  > Add Printer

When  the Add Printer Wizard
screen appears, click Next.

Select Network Printer.

Click Next.

Type in the path, if you know it,
or click Browse.

TCP/IP Printing for Windows 98SE/Me (continued)
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TCP/IP Printing for Windows 98SE/Me (continued)

At the next screen, browse for the printer
port. Highlight the port as shown. (The Port
Name in this window is just an example.)

Click OK.

If the network path is not specified, type in
the IP address of the DP-301P+ and the
Port Name. (The Port Name shown at right
is just an example.)

Select Yes or No, to answer the question:
Do you print from MS-DOS based pro-
grams?

Click Next.

Click Next.

Click Next.

Highlight the printer, as shown. If the desired
printer is not on the list, click Have Disk and
insert the printer driver disk that came with
your printer to install the printer drivers.

PS-116688-P1

192.168.0.10\PS-116688-P1
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TCP/IP Printing for Windows 98SE/Me (continued)

Select Yes to print
a test page.

Click Finish.

Go to Start >
Settings > Printers
Check to see that your
printer is installed.
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Unix/Linux Printing

Please refer to the PS Admin Manual on the CD included with your DP-301P+
purchase for information on setting up the print server in Unix/Linux.



49

Setting up Apple Talk or LPR
Printing in Mac OS X

At the Configure
pull-down menu,
select Manually

Note: Mac OS printing is supported by PostScript printers only!

Open your System
Preferences
window and click
Network.

With Mac OS X you can use AppleTalk or LPR printers using IP protocols for printing
through print servers. Follow the instructions below to set up the print server.
After attaching the print server to your network using the directions provided in the
Quick Installation Guide, change the IP address of your Macintosh to access the
print server’s Web configuration.



50

The default IP address
of the print server is
192.168.0.10. Manu-
ally change your IP
address to
102.168.0.x, where x
is any number be-
tween 1 and 254
(except 10 which is
the IP address of the
print server.) The IP
addresses and subnet
mask shown here are
examples only.

Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the AppleTalk
tab in this window
and check Make
AppleTalk Active.
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

To print, open a document
and select File > Print
from the menu.

Select Edit Printer
List from the Printer
dialog box.

Click  Add Printer
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

Select the printing
protocol preferred,
AppleTalk or LPR
Printers using IP.

AppleTalk protocol:
After selecting
AppleTalk the Port
Name of the print
server will be dis-
played. The Port
Name shown here is
an example only.

Click on the port to
which the PostScript
printer is connected.

In this example,
AppleTalk has been
selected.

PS - 1123D6-U1 Laserwriter

Then select the printer model from the dialog box displayed here.
Click Add Printer and the printer port configuration is complete.
Select the printer port just configured in the print window.
Click Print to print your document.

PS - 1123D6-U1 Laserwriter

PS-116688-P1

PS-116688-P1
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Setting up Apple Talk or LPR Printing
in Mac OS X (continued)

LPR Printers using IP
protocol:
When you select LPR
Printers using IP Proto-
col, this window  will ap-
pear.

Type the IP address of the
print server into the LPR
Printer’s Address field.

In the Queue Name field, type in the Port Name of the post-script printer that is
connected to the print server. The Port Name illustrated here is only an example.
Select the printer model from the dialog box.

Select the printer model from the dialog box.

Click Add.

Close all print center windows, select the printer port that was just selected.

Click Print to print the document.

Click Add and the process is complete.

PS-1123D6 - U1PS-116688-P1
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Setting up AppleTalk Printing
in Mac OS 9

The AppleTalk network protocol is used with computers using the Macintosh
operating system. It can be used for network communications over standard
Ethernet or Fast Ethernet using the EtherTalk transport, or over a proprietary
LocalTalk transport.

Your print server can be used for network printing to PostScript printers. You can
print from any Mac OS computer connected to your Ethernet network, either
directly using an EtherTalk connection, or indirectly through a LocalTalk-to-EtherTalk
router.

NOTE: The chooser name of a printer connected to one of the print server’s ports
is the same as its port name. If you are using AppleTalk printing, you will need to
make sure that every port name is unique among all of the network printers in your
AppleTalk zone. The port names shown in this manual are examples only.

Setting up the print server for AppleTalk Printing
To set up your print server so that it can be used for AppleTalk printing:

Note: Mac OS printing is supported for Postscript printers only!

If your AppleTalk network is divided into AppleTalk zones, you will have to
specify which zone the print server should be in. You should locate the print
server in the same zone as most of the users who will be using it. If your
network is not divided into zones, the AppleTalk Zone field should contain a
single asterisk “*”.

Select the Network tab and scroll to the bottom to the AppleTalk protocol
section.

Change the IP address on one of the computers on your network to
192.168.0.x, where x is any number between 11-254, excluding 10.

Type 192.168.0.10 into the address field of your web browser. 192.168.0.10 is
the default IP address of the DP-301P+.

Make sure the AppleTalk protocol is enabled in your Macintosh.�

�

�

�

�
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Printing from Mac OS Client Workstations

The exact procedure for selecting a PostScript printer connected to your print
server may vary slightly, depending on what printer driver version you are using.
The procedure described below assumes you are using the LaserWriter 8.

To choose a printer connected to your print server as your Mac OS
workstation’s default printer,

Open the chooser by selecting Chooser from the Apple menu.

Select the LaserWriter 8 icon on the left. Make sure that AppleTalk is set
to Active.

A list of all networked PostScript printers will be displayed:

Double-click the name of
the printer port you wish
to use. The printer ports
shown are examples only.

PS-116688-P1
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Printing from Mac OS Client Workstations (continued)

If you have not previously
set this printer as the
default, your computer
will prompt you for a
PostScript Printer
Description file. Choose
Select PPD.

If you wish to access this setting in the future, you can use the Setup button in the
Chooser window.

The selected printer will become your computer’s default printer. You may need to
choose Page Setup in any applications you have open.

Select the appropriate
printer description file for
your printer.

Click Open.
(If your printer is not listed,
click Generic to use a
generic printer
description.)

Epson Stylus COLOR 740 ESC/P2
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Technical Specifications
Printer Connection
Printer Port: Parallel port

Bidirectional Communication:

Network Connection
Network Standards:  IEEE 802.3 10Base-T Ethernet

Network Data Transfer Rate:  10/100 Mbps (megabits per second)

Network Connector:  RJ-45 connector for 10Base-T Category 5 twisted-pair connection

Network Protocols
Ethernet Frame Types: 802.2, 802.3, Ethernet II, SNAP (auto-switching)

Transport Protocols:  TCP/IP, NetBEUI, AppleTalk/EtherTalk, LPR

TCP/IP Protocols Supported: BOOTP, SNMP, Telnet, TFTP, FTP, LPD, RARP, DHCP

Management and Diagnostics
Standard:  SNMP

MIBs:  MIB-II (RFC 1213)

Diagnostic LED Indicators:  Pw, Lk/Act, LPT

Environmental and Physical
Power Supply:  External power supply providing 5V DC, 2.5A

Dimensions:  3.54" x 2.20" x 1.02" (90mm x 56mm x 26mm)

Weight:  approx. 4.27 oz. (121g)

Operating Temperature:  32 to122°F (0 to 50°C)

Storage Temperature:  -13 to 131°F (-25 to 55°C)

Humidity:  5% to 95% non-condensing

Emissions:  FCC Class B, CE Class B, VCCI Class B

Warranty
One year limited warranty

Hewlett-Packard PJL (Printer Job Language)  standard
for bi-directional communication.
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You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within
Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our website,
or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:
D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:

•  Serial number of the unit

•  Model number or product name

•  Software type and version number

TTTTTechniechniechniechniechnical Supportcal Supportcal Supportcal Supportcal Support
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Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

• D-Link or its authorized reseller or distributor and
• Products purchased and delivered within the fifty states of the United States, the District of

Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an APO or
FPO.

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link products described below will
be free from material defects in workmanship and materials from the date of original retail purchase of the
product, for the period set forth below applicable to the product type (“Warranty Period”), except as otherwise
stated herein.

1-Year Limited Warranty for the Product(s) is defined as follows:

• Hardware (excluding power supplies and fans) One (1) Year
• Power Supplies and Fans One (1) Year
• Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period at no
charge to the original owner or to refund at D-Link’s sole discretion.  Such repair or replacement will be
rendered by D-Link at an Authorized D-Link Service Office.  The replacement Hardware need not be new or
have an identical make, model or part.  D-Link may in its sole discretion replace the defective Hardware (or any
part thereof) with any reconditioned product that D-Link reasonably determines is substantially equivalent (or
superior) in all material respects to the defective Hardware.  Repaired or replacement Hardware will be
warranted for the remainder of the original Warranty Period from the date of original retail purchase.  If a
material defect is incapable of correction, or if D-Link determines in its sole discretion that it is not practical to
repair or replace the defective Hardware, the price paid by the original purchaser for the defective Hardware
will be refunded by D-Link upon return to D-Link of the defective Hardware.  All Hardware (or part thereof) that
is replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon
replacement or refund.

Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will
substantially conform to D-Link’s then current functional specifications for the Software, as set forth in the
applicable documentation, from the date of original retail purchase of the Software for a period of ninety (90)
days (“Warranty Period”), provided that the Software is properly installed on approved hardware and
operated as contemplated in its documentation. D-Link further warrants that, during the Warranty Period, the
magnetic media on which D-Link delivers the Software will be free of physical defects.  D-Link’s sole obligation
shall be to replace the non-conforming Software (or defective media) with software that substantially
conforms to D-Link’s functional specifications for the Software or to refund at D-Link’s sole discretion.  Except
as otherwise agreed by D-Link in writing, the replacement Software is provided only to the original licensee,
and is subject to the terms and conditions of the license granted by D-Link for the Software.  Software will be
warranted for the remainder of the original Warranty Period from the date or original retail purchase.  If a
material non-conformance is incapable of correction, or if D-Link determines in its sole discretion that it is not
practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) is first returned to D-Link.  The license granted respecting any Software for which a refund is given
automatically terminates.

Non-Applicability of Warranty:  The Limited Warranty provided hereunder for hardware and software of
D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product and in that case, the product
is being sold “As-Is” without any warranty whatsoever including, without limitation, the Limited Warranty as
described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim:  The customer shall return the product to the original purchase point based on its return
policy.  In case the return policy period has expired and the product is within warranty, the customer shall
submit a claim to D-Link as outlined below:

Warranty and Registration
(USA only)
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• The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm the
same.

• The original product owner must obtain a Return Material Authorization (“RMA”) number from the
Authorized D-Link Service Office and, if requested, provide written proof of purchase of the
product (such as a copy of the dated purchase invoice for the product) before the warranty service
is provided.

• After an RMA number is issued, the defective product must be packaged securely in the original or
other suitable shipping package to ensure that it will not be damaged in transit, and the RMA number
must be prominently marked on the outside of the package.  Do not include any manuals or
accessories in the shipping package.  D-Link will only replace the defective portion of the Product
and will not ship back any accessories.

• The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery
(“COD”) is allowed.  Products sent COD will either be rejected by D-Link or become the property of
D-Link.  Products shall be fully insured by the customer. D-Link will not be held responsible for any
packages that are lost in transit to D-Link.  The repaired or replaced packages will be shipped to the
customer via UPS Ground or any common carrier selected by D-Link, with shipping charges
prepaid. Expedited shipping is available if shipping charges are prepaid by the customer and upon
request.

• Return Merchandise Ship-To Address
USA: 53 Discovery Drive, Irvine, CA 92618
Canada: 2180 Winston Park Drive, Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing
requirements, or for which an RMA number is not visible from the outside of the package. The product owner
agrees to pay D-Link’s reasonable handling and return shipping charges for any product that is not packaged
and shipped in accordance with the foregoing requirements, or that is determined by D-Link not to be defective
or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced or
removed; Initial installation, installation and removal of the product for repair, and shipping costs; Operational
adjustments covered in the operating manual for the product, and normal maintenance; Damage that occurs in
shipment, due to act of God, failures due to power surge, and cosmetic damage;  Any hardware, software,
firmware or other products or services provided  by anyone other than D-Link; Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the
liquidators expressly disclaim their warranty obligation pertaining to the product.  Repair by anyone other than
D-Link or an Authorized D-Link Service Office will void this Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY TERRITORY WHERE
A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO NINETY (90)
DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISK AS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF
THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER
ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY
LOSS OF USE OF THE PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
GOODWILL, LOSS OF REVENUE OR PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
FAILURE OF OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED
WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT
RETURNED TO D-LINK FOR WARRANTY SERVICE) RESULTING
FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY BREACH
OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR,
REPLACEMENT OR REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM
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Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some states
do not allow exclusion or limitation of incidental or consequential damages, or limitations on how long an implied
warranty lasts, so the foregoing limitations and exclusions may not apply. This limited warranty provides
specific legal rights and the product owner may also have other rights which vary from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement:  No part of this publication or documentation accompanying this Product may be
reproduced in any form or by any means or used to make any derivative such as translation, transformation,
or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as stipulated by the United
States Copyright Act of 1976.  Contents are subject to change without prior notice.  Copyright© 2002 by D-Link
Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communication. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local D-Link
office.

Register your D-Link product online at http://support.dlink.com/register/

FCC Caution:

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.  The
antenna(s) used for this equipment must be installed to provide a separation distance of at least eight
inches (20 cm) from all persons.

This equipment must not be operated in conjunction with any other antenna.

 LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES ARE
EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to
this equipment; such modifications could void the user’s authority to operate the equipment.
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The Canon Printer

Canon BJC-255SP
Canon BJ-330
Canon BJC-600, 620
Canon BJC-2000SP
Canon BJC-4100, 4300, 4500, 4550
Canon BJC-6000, 6500
Canon BJC-7000
Canon BJC-8200
Canon LBP-720, 740
Canon Bubble Jet S520

The Epson Printer/plotter

Epson Stylus Photo 700, 710, 750
Epson Stylus Photo 870
Epson Stylus Photo 1200, 1270
Epson Stylus Photo EX
Epson Stylus Pro XL
Epson Stylus Color 400, 440, 460, 480
Epson Stylus Color 600, 640, 660
Epson Stylus Color 740
Epson Stylus Color 800, 850, 860
Epson Stylus Color 900
Epson Stylus Color 1160
Epson Stylus Color 1500, 1520
Epson Stylus Color 3000
Epson Stylus C60
Epson LQ-100
Epson LQ-300
Epson LQ-550, 570+
Epson LQ-1070C+
Epson LQ-2070, 2170C
Epson EPL-N2000, N2010

Appendix:

The Fujitsu Printer

Fuji 10V, 14V
Fuji DL-700
Fuji DL-3800

The HP Printer/Plotter

HP Portable
HP LaserJet III
HP LaserJet 4P, 4L, 4V
HP LaserJet 5L
HP LaserJet 6P, 6L
HP LaserJet 1100, 1100A
HP LaserJet 1200
HP LaserJet 2100, 2100M
HP LaserJet 2200
HP LaserColorJet 8500
HP DeskJet 400, 420
HP DeskJet 500, 550C, 560C
HP DeskJet 670C, 695C
HP DeskJet 720C
HP DeskJet 810C, 890C
HP DeskJet 920C
HP DeskJet 930C(new), 970CXI
HP DeskJet 1120C
HP DeskJet 1125C
HP DesignJet 350C
HP DesignJet 600C
HP LaserJet 4000
HP LaserJet 5000
HP OfficeJet T45, 710

DP-301P+ Printer Compatibility List

Epson EPL-5500, 5700, 5700L, 5800

The IBM Printer

IBM 5577
IBM 4039 16L
IBM Infor Printer 20
IBM InfoPrint 32
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Appendix: DP-301P+ Printer Compatibility List (continued)

 The Lexmark Printer

Lexmark 4039 10R
Lexmark 5700
Lexmark Optra Color 45
Lexmark Optra C710
Lexmark Optra E, E+, E310
Lexmark Optra K1220
Lexmark Optra M410, M412
Lexmark Optra N
Lexmark Optra R+
Lexmark Optra S1250, S1855
Lexmark Optra SC-1275
Lexmark Optra SE-3455
Lexmark Optra T614
Lexmark Optra W810
Lexmark Z53

The NEC Printer

NEC P2200
NEC P3200
NEC P5300
NEC P6300
NEC P7300

Other Printers

Brother HL-1260
CD T120
Citizen GSX-230
Futek 84+
OKI ML-391
OKIdata OL-400
Olivetti JP450
Panasonic 2023
Panasonic KX-P1624
Printtec PR856C
Star NX-2420
Tektronix Phraser 350

Other printers from the brands listed above may also be supported.
For an updated compatibility list please visit: http://www.support.dlink.com

 (03/01/2004)
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